
Program: Membership plus 2007  
 
Issue:       How to Archive 
 
 
Archiving old data  
 
Archiving puts time-sensitive transaction data you are no longer using into storage by 
removing it from your current data set and storing it in another location. You can access, 
view, and edit your archive data set, but you cannot add to it.  
 
Generally you'll want to archive data shortly after the end of your organization's fiscal 
year. Membership Plus provides a wizard that helps you with the procedure.  
 
Before you archive your Membership Plus data, be sure you have a current backup of 
your data set.  
 
 
To launch the Archive Wizard,  
 
·    From the File menu, choose Data Set Maintenance, then choose Archive from the 
submenu.  
 
The Archive Wizard is structured as a series of choices and questions, each step 
contained in one of a sequence of dialog boxes.  
 
Instructions:  
Step 1  
 
Choose type of data to archive (Step 1, Archive)  
 
Step 1 of the Archive Wizard is to specify the type of data you want to archive. Only 
time-sensitive data can be archived. Time-sensitive data is directly related to meetings, 
attendance, member notes, deposits, contributions, and pledges—any piece of data that 
has a date attached to it—and is significant for a limited time only.  
 
To indicate your selection,  
 
1.    Mark the check boxes that correspond to the type(s) of data you want to remove from 
your current, active data set.  
 
2.    For example, you might want to remove all the old data, or maybe you only want to 
remove the old financial data (and keep the meeting and note data for ongoing use).  
 
3.    When you've indicated your selections, click Next to proceed.  
 



Choose date range (Step 2, Archive)  
 
Step 2 of the Archive Wizard is to specify the time frame for the data you want to 
remove from your current, active data set. For example, you might want to remove all the 
data up to the end of the previous calendar or fiscal year. Or maybe you want to keep the 
previous fiscal year but remove anything older than that.  
 
To specify the date range,  
 
1.    Use the month pick lists and year spin buttons to set the beginning and end of the 
desired date range.  
 
2.    All data from the first day of the From month to the last day of the To month will be 
archived.  
 
3.    When you've specified the desired date range, click Next to proceed.  
 
Choose location (Step 3, Archive)  
 
Step 3 of the Archive Wizard is to specify the location where the archived data should be 
placed. Archiving creates a data set that is fully functional (except that you cannot add 
records to it), so this step is simply a matter of identifying a directory, usually on your 
hard drive.  
 
To choose a location for the archive data set,  
 
·    Click the Browse button, then use the Select Directory dialog box to identify the 
desired directory.  
 
o    Frequently you may want to create a new directory.  
 
o    If you specify a directory that contains a valid non-archive data set, you'll be asked to 
select a different location.  
 
o    If you specify a directory that contains a valid archive data set, the Choose Archive 
Option dialog box provides additional options.  
 
When you've identified the correct location for the archive data set, click Next to proceed  
 
Perform archive (Step 4, Archive)  
 
Step 4 of the Archive Wizard is to perform the archive procedure, removing the old data 
from the active data set and placing it in the new archived data set.  
 
To begin archiving your data,  
 



·    Click the Archive button.  
 
A meter bar tracks the progress, and a counter below the meter bar indicates the number 
of records processed.  
 
When the archive is complete, a report appears in a preview window on your screen. 
Review and print the report, if necessary, then close the preview window.  
 
Click Close to complete the procedure. Membership Plus prompts you to reprocess the 
data in the active data set. Because many records have been removed from the current 
data set, leaving wasted empty space, It's a good idea to reprocess at this point. 



How do I convert my existing data set 
to Membership Plus 2007? 

 
Before you begin 

1. Locate the directory path of your current data set. (Listed below are the default paths for prior 
versions:)  

o MP 9 (2005) - C:\MP9Data\Datasets\  
o MP 8 - C:\MP8Data\Datasets\  
o MP 7 - C:\MP7Data\Datasets\  
o MP 6 - C:\My Documents\Membership Plus\Datasets\  
o MP 5 - C:\My Documents\Membership Plus\Datasets\ 

2. Do not attempt to convert your data set directly from a Membership Plus backup file 
[MPLUSWIN.ZIP]. Instead, use a program such as WinZip to unzip the file to a unique folder 
on your computer.  

Converting from Membership Plus 5 - 9 (2005) 

1. Install Membership Plus 2007 and open the program. 

2. MP 8 or 9 (2005): Click the down arrow of the "Data Sets" menu on the Welcome Screen and 
locate your data set below the heading "Previous Versions" and click on it. (NOTE: If your 
data set name does not appear below "Previous Versions", please follow the steps below for 
MP 5, 6, or 7 even if your data set is not from those versions.) 
 
MP 5, 6, or 7: Click on "Browse" next to the "Data Sets" menu on the Welcome screen and 
Browse to the MP 5, 6, or 7 data set folder on your computer. (NOTE: If you are converting 
data from MP 5, 6, or 7, you must initially install MP 2007 and convert your data set on the 
same computer where these versions are installed. Once converted, an MP 2007 backup 
may be easily moved to a different computer.) 

3. Click through the conversion utility to begin the process. (Be patient. This may take some 
time depending on the size of the data set and speed of the computer.) 

4. Click OK at the prompt that says the conversion was successful. 

5. On the Welcome Screen, click on the Browse button. 

6. Browse to the data set location you created in step #3. 

7. Confirm the data set is correct by clicking on “Yes” to view the properties. 

8. When confirmed, run this database utility from the File menu: “File - Dataset Maintenance - 
Verify - Perform Verify...” 

9. Follow any instructions listed in the Verify Report 

Converting from Membership Plus 4 and earlier 

• Your data set will need to be converted by Tech Support. Contact them for detailed 
instructions. 
 
Email:  help@quickverse.com 
Phone: (402) 333-3075 

 



Product: Membership Plus 2007 
 
Issue: How to create a backup of your dataset 
 
Solution: 
 
To create a backup of your dataset first open Membership Plus 2007. 
 
Now click File, point to Backup Data, click on Create Backup. 
 
You are first asked where to create the backup file, delete the current path in the text field 
and replace with C:\MP Backup and click Continue. 
 
You will see a confirmation window stating that the specified directory does not exist, 
asking if you want to create it, click Yes. 
 
You are then asked if you want to backup report generator tables and unless there are 
reports that you have altered or created from scratch skip this step and just click 
Continue, otherwise place a check in the box and click Continue. 
 
The backup process should proceed and complete and you will now have a backup file in 
the MP Backup folder located on you’re C: drive. 
 



 
 
How to print a check 

1. Start by clicking on the Accounting Module.  
2. Then click on Transactions.  
3. Once you have Transactions open click on the Chk Print tab.  
4. You can combine multiple checks into one if you'd like but if not just select the 

checks you want.  
5. Then click on the Setup button for the style of check that you want.  
6. Click on the print button and you will be presented with the "Print Selected 

Checks" dialog box.  
7. Select the date that you want and what printer your going to use and click on Ok 

to print.  

 



How do I keep my data set running smoothly? (Reprocess) 

Reprocess your data set 

• Reprocessing compresses the space left from deleted records in order to make better 
use of your disk space. It also rebuilds the indexes for your data set in case any of them 
need it. It does not change the data you have entered.  

How to Reprocess 

1. From the File menu, choose Data Set Maintenance, then choose Reprocess Data from 
the submenu. 

2. The Reprocess Data Set dialog box displays a meter bar so you can monitor the 
progress. Any problems encountered are reported. When the reprocess is complete, the 
dialog box closes and you are returned to the desktop. 
Follow any instructions listed in the Verify Report 

Tip 

• If you experience problems with your data, reprocessing might not be enough. You may 
need to verify and repair the data. 

 



Product: MembershipPlus 2007 
 
Issue: Restore Backup 
 
Description:  A Membership Plus backup file is a compressed file that cannot be used by the program except by restoring it. 
 
Solution: 
 
Note: It is highly recommended that a Reprocess Data, followed by a Verify & Repair, are performed first prior to backing 
up the dataset.  This will assure that the dataset is “clean”  
 
From the File menu, choose Back Up Data, and then choose Restore Back Up from the submenu. 
 

 
 
In the Restore dialog box, specify the directory where the compressed backup file is located.  
 

 
 
Click the Select Button if necessary, to open the Select Directory dialog box.  
 

 
 
 



Click Continue to proceed. 
 

 
 
Indicate whether you want to restore the backup to the open data set (replacing the current data files) or to a different 
directory. Replacing the current problem data set requires less hard drive space but is more risky if the process fails for any 
reason. Click Continue to restore the files. 
 

 
 
While the files are being restored, the Restore dialog box displays meter bars to indicate the file being added to the database 
and the percentage of completion. 
 

 
 



Membership Plus informs you when the restoration is complete. 
 

 
 
 
 
 



How do I configure the Accounting Module to track Contributions and  
Deposits? 
 
Answer: 

Phase 1: Bank(s) 

 Step 1 

Before you record deposits in Membership Plus, you need to set up information for the banks 
where you will be making those deposits. 

1. Open Membership Plus.  
2. Click on Module from the menu bar.  
3. Click on Financials, scroll over and choose Banks.  
4. Click the Add button.  
5. Enter the name of your bank (example: My First New Bank)  
6. Enter the bank account description (example: Main Checking)  
7. Enter the ABA number (Actual bank account number)  
8. Click the Save button.  

Step 2 

1. Open Membership Plus.  
2. Click on Module from the menu bar.  
3. Click on Accounting, scroll over and choose Accounts.  
4. NOTE: If you have not previously created any accounts, select “Proceed with no 

accounts”.  
5. Click the Add button.  
6. Select Checking or Savings depending on what Account Type you have at your bank.  
7. Enter the Account name (example: Main Checking).  
8. Enter the Account number 
9. Enter Additional Information if necessary.  
10. Validate the Creation date is correct.  
11. Click the Save button.  

Phase 2: Fund(s) 

You'll use the Funds module to record and view information about the funds your organization 
uses to track pledges and contributions. 

1. Open Membership Plus.  
2. Click on Module from the menu bar.  
3. Click on Financials, scroll over and choose Funds.  
4. Click the Add button.  
5. Enter the name of your Fund (example: My New Fund).  
6. Optionally, enter an account number (example: 12345).  
7. Make the appropriate selection for the “Tax Deductible” and “Active fund” boxes.  
8. For now, do not make any entries in the Account Links section.  
9. Click the Save button.  

 



 

Phase 3: Account(s) 

To track your Financials in the Accounting Module, you’ll need to link your bank(s) and fund(s) to 
the appropriate INCOME account(s). The following steps walk you through the process of 
creating an income account, although you could just as easily edit an existing income account. 

12. Open Membership Plus.  
13. Click on Module from the menu bar.  
14. Click on Accounting, scroll over and choose Accounts.  
15. NOTE: If you have not previously created any accounts, select “Create a Default Chart of 

Accounts”.  
16. Click the Add button.  
17. Select INCOME for Account Type.  
18. Enter the Account name (example: My New Income Account).  
19. Enter Additional Information if necessary.  
20. Validate the Creation date is correct.  
21. Click the Save button.  
22. Click on the “Links” tab toward the bottom of the Accounting module.  
23. The upper table contains the newly created fund in Phase 2 “My New Fund”. Click the 

right pull-down box and select the newly created Income Account.  
24. The lower table contains the newly created bank in Phase 1 “My First New Bank”. Click 

the right pull-down box and select the appropriate bank account (usually just “Bank 
Account”).  

25. Your Bank, Fund, and Income Account have now been linked.  

 



Program: Membership plus 2007  
 
Issue:       Verify and Repair 
 
Verifying and repairing data 
 
If you experience problems with your data, reprocessing might not be enough. You may 
need to verify and repair the data. Verifying makes sure your data is not corrupted, so that 
all program functions run smoothly.  
 
To verify and repair your data, 
 
·From the File menu, choose Data Set Maintenance. Choose Verify from the submenu, 
choose Perform Verify. 
 

 
 
The Verify and Repair procedure is structured as a series of choices and questions, each 
step contained in one of a sequence of dialog boxes. 
 
Select areas and process (Step 1, Verify and Repair) 
 
Step 1 of the Verify and Repair process is to identify the data elements to verify and the 
type of procedure to perform. 
 
To specify your preferences, 
 
1. Use the check boxes to select the desired data elements in the Areas box. You can 
select to verify any combination of the following: 
 
· Members and Groups 
 
· Meetings 
 
· Contributions                                           
 
· Pledges 
                                                                                                                     



· Tools                                                   
 
· Reports and Filter 
 
· Surveys 
 
· Schedule 
 
· Accounting 
 
Generally it's a good idea to verify all the information. 
 
2. Mark the radio button that corresponds to the type of process you want to 
perform. 
 
· Verify and Repair—Checks for bad links and erroneous data. Select this process 
for routine maintenance or if the data set was not closed properly (as in the case of a 
power outage, for example). 
 
· Low Level Repair—Repairs bad data that causes translation errors. Select this 
process if you receive a Translate Error message while operating the program or if your 
hard drive is exhibiting other problem signs. 
 
· Check Table Structures—Looks for database fields and verifies that they are of 
the type and length expected by the Membership Plus program. Select this process if you 
or someone in your organization has viewed or edited the database files using another 
program. 
 
When you've made your selections, click Next to proceed. If you selected the Verify and 
Repair process, you'll move to Step 2; otherwise you'll skip to Step 3. 
 

 
 



Select data to verify and repair (Step 2, Verify and Repair) 
 
Step 2 of the Verify and Repair process is to specify your preferences for repairing 
various data elements, if you selected to perform the Verify and Repair process (instead 
of Low Level Repair or Check Table Structures) in Step 1. 
 
To select the data to verify and repair, 
 
· Click each of the following tabs in turn, and mark the options that correspond to 
how you want Membership Plus to handle each item. Or click Select all 
 
o Members 
 
o Notes 
 
o Groups 
 
o Meetings 
 
o Contributions 
 
o Deposits 
 
o Pledges 
 
o Events 
 
o Schedules 
 
o Surveys 
 
When you've made your selections, click Next to proceed. 
 

 
 



Check data (Step 3, Verify and Repair) 
 
Step 3 of the Verify and Repair process is to check the data in the data set according to 
your settings in the previous steps.  
 
To launch the verification process, 
 
1. In the Maximum # of Pages field, specify the upper limit of the size of the 
verification report. 
 
2. Membership Plus will stop if and when the report grows to the size you indicate. 
Because the report is stored on your hard drive, it's best not to set the page count too 
high. You can fix the indicated problems and repeat the procedure until no errors appear.  
 
3. Click the Proceed button. 
 

 
 
A meter bar in the upper left corner tracks the progress, and the box below updates as 
errors are found. When told that the process has completed click the Ok button. 
 
When the verification is complete, an error report appears in a preview window on your 
screen. Review and print the report, if necessary, then close the preview window. 
 
The next step of the Verify and Repair process is to fix the problems identified in the 
verification report. 
 
Correct errors (Step 4, Verify and Repair) 
 
Step 4 of the Verify and Repair process isn't a "process step" like Steps 1-3. Instead, the 
next step is to fix the errors identified in the verification report, then repeat the procedure 
until no more errors are found. 
 



To correct errors in your data, 
 
· Review the necessary actions identified in the verification report and make 
changes, as necessary. Then repeat the Verify and Repair procedure to locate any 
additional errors. 



Follow the instructions in the box below to download and install this maintenance release: 

Verify Your System 

1. This update is only valid for Membership Plus 2007 (Standard or Deluxe) 
users.  

2. The program must be installed on your computer before installing the 
10.0.1 Maintenance Release.  

3. To see which release is on your computer, follow these steps:  
o Open Membership Plus.  
o Click on the "Help" menu.  
o Select "About Membership Plus".  

Download the Maintenance Release(s) 

1. To download the 10.0.1 Maintenance Release, click the link below.  

• http://qvdownload.com/downloads/mp10/mntrel/MemPlus1001.exe 

Install the Maintenance Release(s) 

1. Exit the Membership Plus program if you have it running.  
2. Double-click on the appropriate downloaded file(s) to begin installation.  
3. Follow the on-screen installation instructions.  

Verify the Installation 

1. Open Membership Plus.  
2. Click on the "Help" menu.  
3. Select "About Membership Plus".  
4. Verify you see "10.0.1".  

 

Thank you for your on-going support of Membership Plus. 

We continue our commitment to providing the most comprehensive church management software 
at the lowest available price! 

 



Product:  Membership Plus 2007 Version  
Problem: Program will not sort on a user defined field 
 
Solution: 
 
 
 
How to Setup a User Defined Field filters for more than one user defined field.  
 
(Click the select button) 
.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click the Add button. 



 
 

 
 
Type in a Name for your filter, this can be anything.  The description is optional and once 
you have finished press the OK button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
On this screen you need to click on the advanced button 



 

 
 
Click the (+) sign next to Member User Fields 

 
 
 
 



Click on the (+) sign next to the user defined field you would like to display on the 
report, and then click on the contents field that displays below the user defined field. 
Once you have the contents highlighted all you must do is click the Filter Value Field.  
 

 
 
 
 
Once you click on the filter value it will prompt you to choose a value, the only values 
that appear are the ones you have entered. Select one from the list and then click the 
ADD button. 
If you would like to include more than one user defined field Click were it says AND/OR 
and choose AND, then repeat the steps above.  
 
Once Finished press OK 
 
Then it will take you back to the original screen were you can just click select, it will then 
choose the filter and you can proceed to view the report. 
 
 



MP2007 Uninstall 
 
1. Click the Start button  
2. Open the Control panel ( settings - control panel) 
3. Double click Add/Remove programs 
4. Highlight Membership plus 2007 
5. Click Change/Remove 
6. Follow prompts to uninstall  
7. Restart computer once completely removed 

1. Open My Computer  
2. Then click on the C:\ drive 
3. Look for MP10Data and delete this folder (right click on folder, left click 

on delete) 
4. Also look for MP10DataBackup folder and delete this one as well 
5. Then go into Program Files from the C:\ and look for Membership Plus 

(C:\Program Files\Membership Plus) and delete this folder as well. 

 
8. Insert cd and turn of anti-virus software. 
9. Begin installation 



Here are some ways to set up a Simple or an Advanced network.  
 
 
Question 1:What is a SIMPLE way to set up Membership Plus on a network?  
*Answer:     
 
*BEFORE YOUR BEGIN*: You must know the location of your data set. First-time 
users must create a data set before proceeding. If you are new to basic networking skills 
and need some advice, click the link below for an excellent how-to guide from Linksys, 
one of the leaders in network technology.  
 
Linksys Network Basics 
<http://www.linksys.com/servlet/Satellite?childpagename=US%2FLayout&packedargs=
c%3DL_Content_C1%26cid%3D1114037291160&pagename=Linksys%2FCommon%2
FVisitorWrapper>  
 
*SIMPLE NETWORKING IN MEMBERSHIP PLUS*:  
 
 1. Share your Membership Plus data set folder on ANY computer in your  
 network.  
  2. Set the Security/Permission levels for this shared folder to "Everyone" with "Full 
Control".  
  3. Open Membership Plus on any networked computer, find the "Data Sets" line on the      
Welcome screen, click "Browse", and locate the folder shared in step #1 above.  
  4. Browse through the members and verify you are in the right data set.  
 
 
*Top* <http://quickverse.com/shopfiles/Faq.asp?ID=43042&hdn=#top>  
 
Question 2: What is an ADVANCED way to set up Membership Plus on a network?  
*Answer:     
 
*BEFORE YOU BEGIN*: The instructions below are intended for those who have an 
advanced understanding of Microsoft networking technology. The assumed networking 
environment for these steps is one containing a domain server and client PC's.  
 
*ADVANCED NETWORKING IN MEMBERSHIP PLUS*:  
 
 1. Create a group on the domain server called something like  
  [Membership Plus Users]. Add any domain users who need access to Membership Plus    
to this group.  
  2. Create a new folder on the domain server and copy/paste the entire contents of the 
existing Membership Plus data set folder to this new location.  
  3. Share this new folder and give "Full" access rights (read/write) to the group you 
created in step #1 above.  
  4. On each client PC, login as one of the domain users you listed in step #1 above, make 



sure Membership Plus is installed correctly, open the program, find the "Data Sets" line 
on the Welcome screen, click "Browse", and locate the domain folder shared in step #1 
above.  
  5. Browse through the members and verify you are in the right data set.  
 
*NOTE*: It is not necessary to install Membership Plus on the domain server; however, 
it is recommended. Any data set maintenance is best done from the domain server itself 
instead of a client PC.  
 
<http://quickverse.com/shopfiles/Faq.asp?ID=43042&hdn=#top> 

 



Access Rights Setup 
 

Deleting access rights 
 

You may want to delete an access name and associated access rights, especially in the 
case where one of the users of the program leaves the organization or will no longer be 

responsible for working with the program. 
 

In the Access Rights Setup dialog box, click to select the access name you no longer need 
and click Delete. The access name is removed from the data set. 

 
Tip 

 
· only an Administrator can delete a password. 

 
· The Administrator and Default access names provided by Membership Plus 
cannot be deleted. 
 

Enabling and disabling access rights 
 

Access rights are initially disabled. In addition to setting up access rights, you need to 
enable their use for the data set.  

 
To enable access rights, 

 
· In the Access Rights Setup dialog box set the Access Rights Enabled/Disabled 

button so that it is raised and labeled Enabled. 
 

To disable password protection, 
 

· Return to the Access Rights Login Administration dialog box and set the Access 
Rights Enabled/Disabled button so that it is depressed and labeled Disabled. 

 
Tip 

 
· Access rights can be enabled or disabled at any time, but the restrictions or lack of 

them apply to all users. (You can't require some users to log in with a password while 
others bypass that step.) 

 
· Only Administrators can enable or disable access rights. 
 

Changing a password 
 

For enhanced security, you may want to change your password periodically. 
 

To change your password, 



 
1. From the File menu, choose Access Rights, and then choose Change Access 

Password from the submenu to open the Change Access Rights Password dialog box. 
 

2. Enter your current password. 
 

3. Enter your new password, and then retype it to confirm it. 
 

4. Enter a new hint, if desired. 
 

5. Click OK to return to your previous program location. 
 

Tip 
 

· Administrators can change passwords in the Access Rights Login Administration 
dialog box. 
 

Levels of access 
 

For each restricted user of a data set, you can set access to various areas of the program at 
the following levels: 

 
· None—This level allows the user no access to the specified area of the program. 
When access rights are set up and the user has logged in, options that are not available to 
this user are dimmed in the menu and toolbar. Page buttons within modules also may be 

dimmed, as appropriate. The restricted user also cannot run reports for data related to this 
area of the program; the report types are unavailable in the Report Generator. 

 
· View—This level allows the user to view data that has been entered in the 

program, but he or she cannot add, modify, or delete records. 
 

· Edit/View—This level allows the user full access to data for the specified area. 
 

Logging in with your access name and password 
 

If access rights are enabled for a data set, you'll have to enter your access name and 
password each time you open that data set. Once the data set is open, a different user can 

log in to access the areas of the program to which he or she is entitled. 
 

To log in when the data set is first opened, 
 

· Select your Access Name from the pick list in the Access Rights dialog box, and 
then enter your password. Click OK to proceed. 

 
To log in as a different user, 

 



1. From the File menu, choose Access Rights, and then choose Access Login from 
the submenu. 

 
2. Select your access name and enter your password in the Access Rights dialog 

box and click OK. 
 

Restricting specific areas 
 

You can use access rights to restrict access to only those areas that the user of the access 
name needs to see. For example, the church secretary might have access to the member 

and meeting records, but only the treasurer has access to the financial records. Access can 
be restricted to the following areas of the program: 

 
· Members—Restricts access to information in the various members modules 

(individuals, families, and organizations. 
 

· Notes—Restricts access to notes entered for members. You can set separate 
restrictions for each note type, if necessary (as in the case where general information is 

entered on some pages but confidential information on another). 
 

· Groups—Restricts access to information in the Groups module. 
 

· Meetings—Restricts access to information in the Meetings module. 
 

· Pledges—Restricts access to pledge information entered in the Pledges module 
(and viewable in the Member Browser). 

 
· Contributions—Restricts access to pledge information entered in the 

Contributions module (and viewable in the Member Browser). 
 

· Visitation—Restricts access to information in the Visitation Module. 
 

· Scheduler—Restricts access to information in the Room and Equipment 
Scheduler Module. 

 
· Event Registration—Restricts access to information in the Event Registration 

Module. 
 

· Backup—Restricts the user's ability to back up the data set. 
 

· Restore—Restricts the user's ability to restore a backed up data set (preventing 
potential accidental overwriting of data). 

 
· Archive—Restricts the user's ability to archive a data set. 

 
· Import—Restricts the user’s ability to Import information into the data set. 



 
· Export—Restricts the user’s ability to Export information out of the data set. 

 
· Search/Replace—Restricts the user’s ability to Search/Replace data in the data 

set. 
 

· Surveys—Restricts access to information in the Surveys module. 
 

· Workflow—Restricts access to information in the Workflow module. 
 

· Progress Tracker—Restricts access to information in the Progress Tracker 
module. 

 
· Accounts—Restricts access to information in the Accounts module. 

 
· Transactions—Restricts access to information in the Transaction module. 

 
· Payees—Restricts access to information in the Payees module. 

 
· Auto Tasks Setup—Restricts access to information in Auto Tasks Setup. 

 
· Auto Tasks Process—Restricts access to information in Auto Tasks Processing. 

 
Tip 

 
· When access to a specific area is restricted or denied, the user also cannot 
generate reports for that area of the program; those report types are unavailable in the 
Report Generator. 



Before you begin 

For a data set to be converted properly, both the previous version and the new 2007 version need 
to be installed on the same computer. You also must know the directory path of your current data 
set. 

(If backup exist on another media type such as Flash drive, CD, or floppy disk, then the dataset 
folder will need to be Unzipped or uncompressed into its own folder on the same computer as 
your new MP2007.) 

 Default paths for prior versions:  

 MP2005 = C:\MP9Data\Datasets\ 

 MP8 =       C:\MP8Data\Datasets\ 

 MP7 =       C:\MP7Data\Datasets\ 

Converting from Membership Plus 7,8 and 9 

1. On the Welcome screen, click on the down arrow under “Data Sets”. 

               

2. Locate your data set below the heading “Previous Versions” and click on it.  

        

        



• If your dataset name does not appear below previous versions please follow the 
steps below for Converting Membership plus 5 and 6, even if your backup is not 
from 5 or 6. 

3. After selecting your data set in the Previous Versions category you will be presented with 
the Conversion Utility window. The first thing you need to do is select the location where 
the converted files should be placed. There will be a default location which you can 
change or leave as is. Click Next 2 times and then click the Process button. 

                    

4. Click ok to the prompt that says the conversion was successful 
5. Now click on the browse button located to the right of the Data Sets selection field. 

        

6. Click on the + sign next to datasets and then choose the folder that you selected as the 
location to have your data set files converted to in Step 3 of this document. Click Ok. 



        

7. Once the data set is converted, confirm the information is correct by clicking on “Yes” to 
view the properties. Click Ok at the bottom of the properties window to confirm and close 
the properties window. 

8. When confirmed, run this database utility from the File menu: “File, Dataset Maintenance, 
Verify, Perform Verify...” 

      

        

9. In the first screen of the Perform Verify window click the Next button at the bottom. 
10. On the second screen click the Select All button and then the Next button. 
11. Now on the third screen click the Proceed button and the database is scanned for errors. 

When the scan is complete click the Ok button and you are presented with an error report 
screen. Maximize the error report screen and take a look at the errors. The error report 
has four separate columns; Status, Error, Record, and Action. The Status column tells 
you what category of error it is, the Error column tells you what the error is associated 
with, the Record column tells you which record the error is in, and the Action column tells 
you what you need to do to correct the error (some errors are corrected automatically and 
you will see that in the Action column). You can print this error report and it’s a good idea 
so that you can have the report in your hand as you are correcting errors in the database. 

12. Now, having cleaned up any errors, run the Reprocess utility by clicking File, Data Set 
Maintenance, Reprocess Data… 

 



 

 

Converting from Membership Plus 5 and 6 

1. On the Welcome screen, click on “Browse” in the “Data Sets” section.  
2. Browse to the MP 5 or 6 data set folder. (If not sure of the location, open MP 5 or 6, click 

on the data set name, scroll to the right, and note the directory path.)  
3. Click through the conversion utility to begin the process. (Be patient. This may take some 

time depending on the size of the data set and speed of the computer.)  
4. Once the data set is converted, click on the “Browse” button on the Welcome screen.  
5. Locate your data set in “MP 10.0 Datasets” and click on it.  
6. Confirm the information is correct by clicking on “Yes” to view the properties.  
7. When confirmed, run this database utility from the File menu: “File, Dataset Maintenance, 

Verify, Perform Verify...”  

Converting from Membership Plus 4 and earlier 

Please contact tech support at help@quickverse.com for instructions to send in your data set to 
be converted. 
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*TIPS* 
 
Throughout this tutorial remember that Funds link to Income Accounts and 
Income/Expense/Checking/Savings Accounts link to Fund Balance 
Accounts. You should create a General Fund Balance account to be used to 
link Checking and Savings accounts to.  
 
Whenever I refer to Banks or Funds I am referring to the banks and or 
funds that you can create from within the Banks or Funds modules located 
in the Financials category.  When I refer to accounts I am speaking of the 
various account types that can be created from within the Accounts module 
located in the Accounting category. 
 
When you get to the point where you are making deposits and you close the 
Contribution module while there are contributions that have not yet been 
deposited, you will be asked if you want to deposit these contributions, 
click No. Open the Deposits module and click the Add button at the top and 
make the deposit this way. If you click Yes when asked if you want to 
make a deposit, there is a chance that the deposit and associated 
contributions will not “trickle” down into the Accounting section of the 
program. 
 
The first time you open the Accounts module you will be asked if you want 
to either Import MoneyCounts data; Create default church accounts; or 
Proceed with no accounts, you should click Proceed with no accounts and 
create the accounts yourself. By creating the accounts yourself you are able 
to better understand the purpose of the accounts.    

 
 
 
 
 
 
 
 



 
 

 
This tutorial is intended to teach you how to configure the Membership 
Plus 2005 Deluxe software so that it will record contributions and the 
corresponding deposits in the Accounting section of the program, 
specifically in the Accounts and Transactions modules. 
 
You will learn how to create Funds; Banks; Fund Balance accounts; 
Checking/Savings accounts; Income accounts, and how to link these 
properly. You will also learn how to enter contributions which have been 
given by church members. 
 
The parts of the program where these actions will be preformed are referred 
to as modules. All of these modules can be accessed from the column 
located on the left hand side of the program window. The categories 
discussed in this tutorial are Financials which contains the Contribution, 
Deposits, Funds, and Banks modules, and Accounting which contains the 
Accounts, and Transactions modules. To expand a particular category to 
see the associated modules simply click the name of the category (in the 
column on the left hand side of the program window). To open a particular 
module, simply click on the name of the module. The Accounting category 
and associated modules are only available in the deluxe version of 
Membership Plus 2005. 

 

 
 
 

Creating Banks 
(Membership Plus 2005 Standard and Deluxe) 
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The first thing that you will need to do is create/add a Bank(s). The purpose of this is 
so that you can deposit contributions that you have entered and so that those deposits 
can be recorded in the register automatically. The register is located in the Accounting 
section of the program, within the Transactions module. 

 
1. Expand the Financials category of Membership Plus 2005 
2. Click Banks to open that module 
3. Click the Add button at the top of the Banks window 
4. In the Name field type the name which you want to see for this Bank Account (like Wells 

Fargo) No two banks can have exactly the same name 
5. In the Bank Account field enter something like Wells Fargo 1 
6. Do not place a check in the box to “Automatically create an Account for this bank for use in 

the Accounting modules”, and leave the fields below that check box empty 
7. Enter the bank accounts ABA number 
8. Click the Save button at the top of the Bank entry window 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 

Creating Funds 
(Membership Plus 2005 Standard and Deluxe) 

 



Now you will need to create all of the Funds that church members give contributions 
to. These funds will be required later when you are entering the contributions. 
 

1. Expand the Financials category of Membership Plus 2005  
2. Click Funds to open that module 
3. Click the Add button at the top of the Funds window 
4. In the Name field enter a name for the fund such as General Fund 
5. In the Account # field enter an account number if desired 
6. If this fund should handle tax deductible contributions place a check in the box for this option 
7. If this fund should be active when created place a check in the box for this option 
8. Ignore the account links below (for now) and click the Save button at the top of the Fund 

creation window 
9. Go ahead and create all of the funds you currently know you need 

 
 

 
 
 
 

Creating Fund Balance Accounts 
(Membership Plus 200 Deluxe) 

 



 
 

At this Time you will want to create the Fund Balance accounts. Remember to 
choose to proceed with no accounts when you open the Accounts module. The 
purpose of a Fund Balance account is to keep track of the balances of each fund. 
When naming the Fund Balance accounts you should name them the same as the Fund 
it will be associated with. For instance if you have a Fund named Offerings the Fund 
Balance account should be named Offerings Fund Balance. Of course what you name 
your funds and accounts is up to you, just be sure that the names reflect the purpose of 
the account or fund. Use the General Fund Balance for Checking/Savings only. 

 
1. Expand the Accounting category of Membership Plus Deluxe  
2. Click on Accounts to open that module 
3. Click the Add button at the top of the Accounts window 
4. Using the drop down menu select Fund Balance as the account type 
5. Enter a name in the account name field 
6. Place a check in the box next to reconcilable if you wan to be able to reconcile the account 
7. If needed enter a beginning balance 
8. Change the creation date if needed 
9. Click the Save button at the top of the Accounts window 
 

 
 

 
 
 

Creating Income Accounts 
(Membership Plus 2005 Deluxe) 

 



 
Here are some things to keep in mind when creating Income Accounts. These 
accounts as well as any other account in the Accounts module have to have a unique 
name. You cannot name a checking account exactly the same name as a savings 
account or any other account type. You can however name an Income Account the 
same name as a fund. For example if you have a fund named General that you have 
also created an Income Account to link with, you can and should name the Income 
Account General Income. 

 
 

1. Expand the Accounting category of Membership Plus 2005 Deluxe  
2. Click Accounts to open that module 
3. Click the Add button at the top of the Accounts window 
4. Set the account type to Income 
5. Enter the desired account name in the Account name field 
6. Enter the desired account number in the account number field 
7. Select the appropriate Fund Balance account in the fund account field 
8. Place a check in box for Reconcilable if you want to be able to reconcile the account 
9. Change the creation date if needed 
10. Click the Save button at the top of the account creation window 

 
 

 

 
 
 

Creating Checking/Savings Accounts 
(Membership Plus 2005 Deluxe) 

 



The next thing that you will neeed to do is create checking and or savings accounts. 
The name which you give these accounts should be the same as the Banks which you 
created earlier. For example if you created a bank named My Bank then you would 
name the Checking account My Bank. 

 
1. Expand the Accounting section of Membership Plus 2005 Deluxe 
2. Click on Accounts to open that module 
3. Click the Add button at the top of the Accounts window 
4. In the add account window set the account type to Checking 
5. Enter the name in the account name field 
6. The account number is optional I would recommend that you use the last four digits of the 

actual account number for your checking/savings account 
7. Select the appropriate fund account in the fund account field (the fund account field is 

referring to a fund balance account) 
8. Select a check style if you will be printing checks 
9. Place a check in the box next to reconcilable if you want to be able to reconcile the account 
10. Change the creation date if needed 
11. Enter a beginning balance if needed and fill in the address information if needed 
12. Click the Save button at the top of the Account creation window 

 
 

 
 
 

Now that you have created your initial banks, funds, fund balance accounts, income 
accounts, and checking/savings accounts, its time to link the funds to their respective 



income accounts and banks to their respective checking or savings accounts. There are 
a couple of way that you can go about doing this however my suggestion would be to 
use the Accounts module and the Links tab in that module, it’s the method which I 
will be describing here. 
 
The Links area is where you link your Funds to the Income accounts which you 
created for them. By linking the Funds to Income accounts you enable Membership 
Plus 2005 Deluxe to keep track of contributions in the Accounting area of the 
program. This is also where you link Banks to Checking or Savings accounts that you 
have created. By linking Banks to the corresponding checking and or savings accounts 
you enable Membership Plus to track deposits made in the Deposits module located in 
the Financials category. 
 

 
Linking Funds to Income accounts 

(Membership Plus 2005 Deluxe) 
 
 

1. Expand the Accounting category of Membership Plus 2005 Deluxe 
2. Click Accounts to open that module 
3. Click the Links tab at the bottom of the Accounts window 

 
 

The Fund to Income account links section has two columns. There is the Fund column 
(on the left) and its labeled MP Fund then there is the Income account column (on the 
right) and it’s labeled Income Acct. The Fund column will have a list of all the funds 
that you have created and the Income Acct column will be blank until you create the 
links. To link a Fund to an Income account left click once in the Income account field 
directly to the right of and on the same line as the Fund. Now click the “dropdown 
menu” button located on the right side of the Income account field and select the 
appropriate Income account. 
 
 

 
 
 

 
 

Linking Banks to Checking or Savings Accounts 
(Membership Plus 2005 Deluxe) 

 



1. Expand the Accounting category of Membership Plus 2005 Deluxe 
2. Click Accounts to open that module 
3. Click the Links tab at the bottom of the Accounts window 
 

You should also create the Bank to Checking/Savings account links. The process is 
the same as linking Funds to Income accounts you are just dealing with Banks and 
Checking/Savings accounts instead of Funds and Income accounts. There is no option 
to save (no save button to click) these link settings the program will do this 
automatically. Once the links are created you can simply move on to the next task. 
 

 
 

With the previously discussed links made there is one more link that needs to be made. I’m referring 
to the link between Income/Checking/Savings accounts and the corresponding Fund Balance 
accounts. This link should have been handled earlier during the creation of the associated accounts 
but I want to go over this process one more time. 
 
The Fund Balance Accounts enable Membership Plus 2005 Deluxe to track the balance of Funds in a 
more detailed manner. When creating Income and Checking/Savings accounts you had the option of 
linking these accounts to the corresponding Fund Balance accounts. There are other account types 
that can be linked to Fund Balance accounts however we will not be discussing these. 
 

 
 
 
 

Entering Contributions 
(Membership Plus 2005 Standard and Deluxe) 



 
At this time you can now begin entering contributions. Though it’s not necessary to do 
a complete configuration of Membership Plus Deluxe (as explained above) before 
entering contributions, you will get the most out of the program if you do. 
 
There are two different types of contribution entry screens. There is the Multi Split 
entry screen where you can enter the currency amount; check number (if the 
contribution is in the form of a check), and select the currency type On the fund side,  
you can split the total contribution amount to more than one fund or choose a single 
fund for the contribution, you can also select whether or not the contribution is tax 
deductible or not. 
 

 
 
 
Then there is the Non-Split contribution entry screen which can be selected after 
entering the default Multi-Split contribution entry screen. To turn off the Multi-Split 
option click Options at the top of the contribution entry screen, in the menu click on 
Multi-Split. 

 
You’re now looking at the Non-Split contribution entry screen. Here you have a single 
contribution entry screen. You can enter the amount of the contribution; a check or 



credit card number; select the fund that the contribution is going to; select the 
currency type, and whether or not the contribution is tax deductible or not. 
 

 
 
 
The type of contribution entry screen you choose is up to you. Both options have 
advantages and disadvantages. Using the Multi-Split contribution entry screen is a 
little more complicated than the Non-Split contribution entry screen. However by 
using the Multi-Split contribution entry screen you can split the contribution to 
multiple funds and that makes entering contributions given by members that want to 
contribute to more than one fund easier.  
 
Using the Non-Split contribution entry screen is a little less complicated than using 
the Multi-Split contribution entry method. There are no fund splits to worry about, 
you can select only one fund per contribution and this method is faster if all you will 
be entering are contributions given to a single fund.   
 
After deciding on which contribution entry screen you want to use its time to actually 
enter the contribution information. We will discuss the Multi-Split contribution entry 
screen first. 
 
 

 
 
 
 
 
 

Multi-Split Contribution Entry 
(Membership Plus 2005 Standard and Deluxe) 

 



1. From within the Multi-Split contribution entry screen select the person or family the 
contribution is coming from. 

2. On the currency side enter the amount; check # if applicable; and select the currency type. 
3. On the fund side enter either the same amount or a portion of the currency total, select a fund, 

and if the contribution is tax deductible place a check in the box for that option. 
 

 
 

4. If you need to choose more than one fund for a single contribution, enter a portion of the 
contribution amount and choose the first fund, on the first line. 

5. Press the down arrow on your keyboard and you get a second fund line where you can enter 
the remainder of the contribution amount or another portion of the remainder and so on. 

6. Click the Save button just above the fund side of the contribution entry screen when you have 
entered the required splits. 

7. Click the Save button at the top of the contribution entry screen to save the contribution. If 
you want to enter another contribution after the first click the Save & Continue button at the 
bottom left and you will get a new/blank contribution entry screen for the next contribution. 

8. When you are finished entering contributions click the Save button at the top of the 
contribution entry screen. 

 
Fund splits have to balance or equal the total amount of the contribution. If they do 
not then the contribution will not have been entered properly and this would cause 
balance issues not only in the Contributions module but in the rest of the 
financial/accounting areas of Membership Plus. If at the bottom of the screen next to 
Variance there is anything other than a zero dollar amount then the fund splits do not 
balance. If there is a variance in red it’s off by a negative amount and if the variance is 
in black it’s off by a positive amount. Membership Plus will not allow you to save a 
contribution with splits that do not equal the total amount of the contribution. 
 
 

Non-Split Contribution Entry 
(Membership Plus 2005 Standard and Deluxe) 

 



There isn’t much to explain regarding the Non-Split contribution entry screen. As you 
can see below it’s fairly simple. To switch to the Non-Split contribution entry screen 
to enter contribution information follow the instructions below. 
 

1. From within the Contributions module click the Add button at the top of the screen. 
2. By default the contribution entry screen is set to Multi-Split to switch to the Non-Split entry 

screen (also explained on page 9) click Options and then click on Multi-Split. 
3. Your now in the Non-Split contribution entry screen 
4. Enter the amount of the contribution, a check or credit card number (if applicable), select the 

fund which the contribution has been given to, and select the currency type. 
5. Click Save at the top of the contribution entry screen or Save & Continue at the bottom left if 

you want to save the current contribution and continue entering more 
6. When finished entering contributions make sure to click Save at the top of the contribution 

entry window. 
 

 
 

The contributions you enter (and save) will be displayed in a list in the Contribution 
module (on the List tab). You will see the date of the contribution; amount of the 
contribution; name of the contributor; batch ID (if you used one); and a note if you 
entered one. Below the list you will see the Split details for the selected contribution 
(if applicable). You can turn off the split detail by clicking Options and then clicking 
on Hide Split Detail. 
 

 
 
 

Depositing Contributions 
(Membership Plus 2005 Standard and Deluxe) 

 



Next you will want to deposit the contributions you have entered. Though this is not 
required if you do not deposit your contributions you will not be taking full advantage 
of the Membership Plus software. Before you can deposit the entered contributions 
you will need to have set up your banks in the Banks module. After entering 
contributions and closing the Contribution module you will be asked if you want to 
deposit those contributions, click No. Open the Deposits module and click the Add 
button at the top of the deposits screen. Now you are in the deposit entry screen. 
 

 
 

In the Deposit Date field you can change the date of the deposit from the current date 
to a previous date if desired. You can in the Select Filter Options area, use a date 
range to determine which contributions will be a part of the deposit by placing a check 
in the box next to Use Date Range and entering the desired dates. You can also use 
batches which you used to enter contributions to have only the contribution batches 
selected for the deposit, simply place a check in the box next to Use Batches. Once 
you have the appropriate contributions listed for the deposit select the appropriate 
bank using the Pick Bank button and click the Save button at the bottom of the screen. 
 
That’s it! You’ve come all the way from square one to depositing the contributions 
you have entered. These deposits will automatically “trickle” down into the register 
where you can see each individual income account balance and each transaction 
associated with the deposit(s). 
 
  
 


